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Assignments

The assignment activity module enables a teacher to communicate tasks, collect work and
provide grades and feedback. Students can submit any digital content (files), such as word-
processed documents, spreadsheets, images, or audio and video clips. Alternatively, or in

addition, the assignment may require students to type text directly into the text editor.

An assignment can also be used to remind students of 'real-world' assignments they need to
complete offline, such as art work, and thus not require any digital content. Students can

submit work individually or as a member of a group.

When reviewing assignments, teachers can leave feedback comments and upload files, such
as marked-up student submissions, documents with comments or spoken audio feedback.
Assignments can be graded using a numerical or custom scale or an advanced grading

method such as a rubric. Final grades are recorded in the gradebook.

> Step 1: Turn editing on

> Step 2: Add an activity or resource

» Step 3: Add Assignment

» Step 4: Add Name of Assignment and Description

Adding a new Assignment

Expand all
General

Assignment name*

Description*

Display description on course page

DISPLAY DESCRIPTION ON COURSE PAGE

Enabling this will display the description on the course page just below the link to the
assignment activity.
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» Step 5: AVAILABILITY

Choices about the availability of an assignment:

Availability
Allow submissions from 9 v || January v | 2015 v | 00 v| 00 ~ ¥ Enable
Due date 16 v || January v | 2015 v |00 v 00 ¥ py@ Enable
Cut-off date 9 v | January v, 2005 v 11 v | 15 ~* Enable
Always show description L4

AVAILABILITY SETTINGS FOR AN ASSIGNMENT

e Allow submissions from
This setting prevents students from submitting their assignment before the date
shown. A teacher can to set a day, month, year and time from which learners can

begin to submit their assighnments.

Please note that this setting does not hide the activity from the learners. Instead, the
learner will see the activity, be able to view the instructions and use any materials
you have included in the description, but the learner will not be able to submit or
complete the assignment until the Allow submissions from date.This setting is
enabled by default and is set at the day and time you added the assignment. To

disable this, remove the tick/check.

e Due date
The Due date setting establishes when the assignment is due. Submissions will still
be allowed after this date, but any assignments submitted after this date are marked
as late. This option allows a teacher to set a day, month, year and time (24 hour
clock) before which learners must submit their assignment.
By default the Due date is Enabled (ticked) and is set at 7 days ahead of the day and
time you selected Add Assignment. To disable this feature, simply ensure the Enable
checkbox is not marked. For more information on using the Due Date see

Assignment
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e FAQ
Assignments without a Due date will appear on the “my home” page with “No Due

date” displayed.

e Cut-off date
The Cut-off date is the date beyond which students will not be able to send in their
assignment as the button for doing so will no longer be displayed. After that date (or
time) a teacher may, on request, grant an extension by going to the class assignment
grading screen, clicking the "Edit" column and choosing "grant extension" for the

relevant student.

e Always show description
If the 'Always show description' checkbox is ticked, the assignment description is
always shown. If the checkbox is not ticked, the assignment description will be
hidden until the 'Allow submissions from' date.

Submission status

gnment details and submis form will be available from Saturday, 22 March 2014, 6:55 PM

Assignment description hidden until the ‘Allow submissions from’ date. If 'Allow
submissions from' is disabled, then this setting has no meaning: the assignment
description will always be visible to students.

» Step 6: SUBMISSION TYPES

Submission types

Submission types

Word limit v

Maximum number of uploaded files

Maximum submission size

Here you can decide how you wish students to submit their work to you.
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https://docs.moodle.org/27/en/File:26submissioncomments.png

Note that if Submission comments are enabled in Administration>Plugins>Activity
modules>Assignment>Submission plugins then students will be able to add a note to

their teacher on submitting work.

UPLOADING MULTIPLE FEEDBACK FILES
It is also possible to upload multiple feedback files as a zip, from the dropdown above the
grading list:

e Download the students' assignments using the "Download all submissions" link from
the same dropdown menu;

e Extract the folder offline and add your comments to the student's submissions. Keep
the names the same.

e Select the students' submissions and zip them into a new folder. Important: Don't
just edit them inside their original folder and re-zip this; it will not work. The folder
name does not matter as long as the feedback files have the same names as before.

e Upload this newly zipped folder.

e You will be presented with a confirmation screen displaying your feedback files.

> Step7:
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Calendar

Calendar events will either be shared with:
= The user that is logged in at that time (User event)
* The users registered for the course (Course event)
= A specific group (if groups are already created) (Group event)

* The entire LMS community (Site event)

» Step 1: On both home screen and module screen, calendar will be on the right

There are no upcoming events

Go to calendar...
New event...

» Step 2: Click on ‘Go to calendar’ or ‘New Event’.
» Step 3: On the Calendar page any activity that you create in your module that has a
specific date assigned to it will show up in your module calendar.

» Step 4: Calendars can be synchronised with your Outlook calendar using the ‘iCal’
icon

Upcoming events New event

Learn Team Training ¥

There are no upcoming events
Export calendar

IManage subscriptions

» Step 5: On the ‘New Event’ page select the type of event and give the event a title

New event
Expand al
General

Font famity Font si o L Ral= 1
BZUmx x E== S 2 @EA Y- mw
B | 2 AdEE 2 o
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e User Event: will only be visible by the user currently logged in

e Group Event: will be visible to a particular Group on the course (chosen from
a drop-down list)

e Course Event: will be visible to participants on the course in question. Only
users with the capability to manage calendar entries at the course level can
add course events.

e Site Event: is a "global" event - visible in every course and on the calendar on
the home page. Only users with the capability to manage calendar entries at
the system level can add site events.

» Step 6: Select specific date for the event
» Step 7: Select the duration of the event
Duration

* Without duration

Uniil

30 v | October v |2014 v | 10 v 20 v

Duration in minutes

» Step 8: You can also decide if you want the event repeated

Repeated events

Repeat this event

Repeat weekly, creating altogether 1
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Chat

The chat activity module enables participants to have text-based, real-time synchronous

discussions. The chat may be a one-time activity or it may be repeated at the same time

each day or each week. Chat sessions are saved and can be made available for everyone to

view or restricted to users with the capability to view chat session logs. Chat are especially

useful when the group chatting is not able to meet face-to-face.

Step 1: Tumn editing on

Step 3: Add Chat
Step 4: Add Name of Chat

YV V V VY V

Step 5: Add Description

General
Name of this chat room*

Description*

» Step 6: Select Chat sessions

Chat sessions
Next chat time
Repeat/publish session times
Save past sessions

Everyone can view past sessions

o Next chat time:

Step 2: Add an activity or resource

9 v| December ~/| 2014 +| 10 v 55 -

Don't publish any chat times v

Never delete messages v

No

The day and hour of the next chat session. This will appear in the calendar so

students know the schedule. If you don’t want them in the chatroom, you can

hide it or restrict access.

o Repeat/publish sessions:

There are four options for scheduling future chat sessions:
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= Don't publish any chat times- there are no set times and students are
welcome to chat at any time.
= No repeats - publish the specified time only- only the Next chat time
will be published. This could be used to schedule special events or
meetings or simply to help learners identify a common time in which
they can expect to find other learners in the chat room.
= At the same time every day- Daily chats are useful for scheduling
daily office hours or work sessions with learners.
= At the same time every week--This setting will schedule a chat for the
same day and time every week, which could be useful for instance for
meeting and reviewing key ideas and questions related to the week’s
content/assessment.
o Save past chats:
Choose from the dropdown how many days to save — or save everything by
selecting Never delete messages. If you have any concerns about discussions
that might take place in your chat room, you may want to keep transcripts to
check the suitability of what is discussed. If your learners are using the
chatroom to collaborate on a group project you won’t want to delete the
messages until the project is complete.
o Everyone can view past sessions:
Decide here whether or not allow everyone to view past chat sessions.
» Step 7: Select Common module settings
These settings are collapsed by default.
» Step 8: Select Restrict Access/Activity Completion
These settings are collapsed by default. These settings are visible if Conditional

activities and Activity completion have been enabled in the site and the course.

> Step 9: Save and retum to course Save and display Cancel
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Clicker

Clicker exercises are useful for classroom assessment. This method of assessment is used in
order to determine the level of understanding that students have of a particular concept
while you are still busy lecturing. The most common method of using the clicker tool is for a
lecturer to have completed a portion of the lecture and then ask the students a
question/questions about the work that has been covered. Student’s responses serve as an

indication of their understanding and what needs to be revised.

Fg".?EEn We advise that if you want to use clicker activities on a regular basis in class, you reset
responses after each class. This way, the students are alerted to the fact that for your class,

they just have to remember one clicker number.

Phase 1: Settings
Click on the following:

» Step 1: Turn editing on
> Step 2: Add an activity or resource

» Step 3: Enter the Name and Description for your Clicker

eneral
Name*

Description® | Sowedangiois

B

Display description on course page

Timing

Clicker options

Common module settings
Restrict access

Activity completion

» Step 4: Set the timing to allow access to the activity during class time only

» Step 5: Do not hide the activity as it will not be available for access if it is hidden

> Step 6: Save and display

» Step 7: Add your questions on the next screen and Save
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» Step 8: The clicker number will appear at the top of the screen. Save this/record this

somewhere for sharing with your students.
Qverview Edit questions Templates Analysis  Show responses

Clicker item number: 44053

Training Clicker

Separate groups
All participants ¥

Submitted answers
Questions: 2

Description

A clicker allows you to create an interactive class with a small or large group of ¢
concepts in class and then ask questions that students can answer using their ¢
QEHEFGNE discussion

Page after submit

Answer the questions...

Phase 2: Preparing to use the clicker activity in class
There are a few tricks to ensuring that your clicker activity goes as planned in class.
» Step 1: Check to see if your students have mobile devices that can connect to the
internet or Wi-Fi (if you have it available in class)
» Step 2: Test out the clicker activity first before using it officially
» Step 3: Explain to the students that you are using this to ensure that they
understand the work
» Step 4: Set up your slides/presentation materials so that clicker activities are used
after a few slides of content before moving on to a new concept.
» Step 5: Most browsers will work, opera mini is best for Nokia and Blackberry if they
are not using newer devices.
» Step 6: Encourage the students to bookmark the page on their phones:
yourls.sun.ac.za/c
» Step 7: This address is the ONLY way for them to participate in the clicker activity

correctly. They should not be accessing the activity via SUNLearn.
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Phase 3: Access for students
How to tell the students how to access the clicker

» Step 1: Instruct students to go to http://yourls.sun.ac.za/c

YOS, SUN. &0, 29/ 6

Clicker

YOS, SUn.ac. 29/

Student number

Clicker number
44053

Submit

233 A5 64 [ 890

@ # $ % & + 2?2 /
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http://yourls.sun.ac.za/c

» Step 3: Students respond to the question
» Step 4: Students click submit

‘b
c
d

Do you noed a break?*

5 Vor
Na
Letus finien up

Phase 4: Viewing responses

To view the responses of students:
» Step 1: Click on the Clicker activity on your SUNLearn page
» Step 2: Click on Analysis

Overview Edit questions Templates .Al1a|§.-‘sjﬁm Show responses

» Step 3: The analysis will give you an overview of the responses

» Step 4: You can export to excel from there

Export to Excel

View on the web

Submitted answers: 5
Questions: 2

- a — 2 (40.00 %)

- b — | (20.00 %)

e —— 1 (20.00 %)

- d: 0

- e — 1 (20.00 %)

() Do you need a break?

- Yes: 3 (60.00 %)
- Nox — 7 (40.00 %)

- Let us finish up: 0
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Phase 5: How to reset responses to allow you to use the clicker number again:

» Step 5: Click: Course administration in the left navigation bar

» Step 6: Click Reset

Course administration
TuhJediting off
Edit settings
Course completion
Users
Unenrol me from Leam Team Training
Filters
Reports
Grades
Outcomes
Badges
Backup
Restore
Import
Publish

Reset
Question ba

» Step 7: Scroll down to Clicker and select the one you would like to reset:

Clicker

» Step 8: Click

Reset clicker responses

Call Leg

Training Clicker -'{b

Reset course

» Step 9: This will reset that particular activity only. DO NOT click anything else on

that page.
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Completion Tracking

» Activity settings
Depending on the type of activity, there are different completion requirements. For
example, a Page might have the requirement to require view; a Quiz might have the
requirement to require grade while a Forum might have the requirement to require

posts/discussions/replies.

» Completion Tracking
There are three options:
¢ Do not indicate activity completion - this will not show checks(ticks)next to the
activity
e Students can manually mark the activity as completed - students press the
check (tick) to change it.
e Show activity as complete when conditions are met - the selected completion

criteria must be met before the check(tick) will change style

» Require view
When this option is turned on, students have to view the activity in order to complete it. In

most cases, clicking the link is enough to 'view' the activity.

You should usually not turn on the 'view' condition if you have other requirements - this
makes extra work for the server and it's unlikely that a student could meet any other

conditions without viewing the activity.

» Require grade
When this option is turned on, students have to get a grade on the activity in order to
complete it. For example, a quiz would be marked completed as soon as the user submits it.
It does not matter how well the student did. Getting any grade will mark the activity

completed.
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https://docs.moodle.org/22/en/Page
https://docs.moodle.org/22/en/Quiz
https://docs.moodle.org/22/en/Forum

It is possible to distinguish between 'pass' and 'fail' grades so that the activity becomes
‘completed, passed' or '‘completed, not passed' instead of just 'completed'. These results

show a different icon and alternative text.

» To set this up, you need to specify the pass value for this activity's individual grade:
e Go to the course gradebook by clicking the 'Grades' link on the course
administration block.
e From the 'Choose an action' dropdown, pick 'Categories and items'.
e Click the Edit icon next to the grade item for this activity.
e Turn on 'Show Advanced'.

e Type a grade value (e.g. 5.0) in the 'Grade to pass' box.

Once you have done this, anybody submitting the quiz will receive either the pass or fail
completion icon. If the quiz can be taken multiple times, the completion icon will

automatically update whenever the grade does.

There is one limitation: this only works if grades are immediately visible to students. The
grade must be neither permanently hidden, nor hidden until a certain date. If a grade is
hidden then only the standard 'completed' state will be displayed - even once the hidden

date has passed.

» Expect completed on

The date is not shown to students and is only displayed in the Activity completion report.

» Require posts
This setting is seen in forums. For the forum to be classed as "complete" the student must
either start a discussion or reply to a discussion. The number of posts they must make can

be specified in the box.

» Require discussions
This setting is seen in forums. For the forum to be classed as "complete", the student must

start a discussion topic. The number of posts they must make can be specified in the box.
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https://docs.moodle.org/22/en/Activity_completion_report

» Require replies
This setting is seen in forums. For the forum to be classed as "complete" the student must

reply to a discussion. The number of posts they must make can be specified in the box.

» Locked completion options
If at least one person has completed an activity, completion options are 'locked'. This is
because changing these options may result in unexpected behaviour. For example, if
somebody has ticked an activity as manually completed, and you then set it to automatic
completion, the activity will become unticked - very confusing for the student who had

already ticked it.

» What happens when you unlock
Once you unlock options and then click 'Save changes', all completion information for the
activity will be deleted and, if possible, regenerated according to the new settings. If the
new completion option is manual, everyone will be set to 'not completed' regardless of any

previous setting.

If it is automatic then, depending on the options chosen, the system may or may not be able
to construct a correct current value for everyone. The 'viewed' requirement will not work -
even if a student has viewed the activity before, it will not be marked completed until they
view it again. Most other options will be recalculated successfully. If you change completion

options while a student is logged in, they may not see the changes for some minutes.

» Required site settings
To use activity completion, the feature needs to be enabled for the site by an administrator
as follows: In Settings > Site administration > Advanced features check the "Enable

completion tracking".

» Required course settings
Settings > Course administration > Edit settings and look for the Student progress section.

You must select at least "Enabled, control via (course) completion and activity settings".
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https://docs.moodle.org/22/en/Advanced_features

Create a Book

The book module enables a teacher to create a multi-page resource in a book-like format,
with chapters and subchapters. Books can contain media files as well as text and are useful

for displaying lengthy passages of information which can be broken down into sections.

Don’t

FORGET!
£
CIC)

A book is useful for:
e To display reading material for individual modules of study
e As a staff departmental handbook

e Asashowcase portfolio of student work

To create a book:
> Step 1: Turn editing on
> Step 2: Add an activity or resource
» Step 3: Add Book
» Step 4: Add Name and Description

General
Name*

Description*

Display description on course page

» Step 5: Select Appearance

These settings are collapsed by default

Appearance

(These default.)

Appearance

Chapter formatting @ [ Numbers [v

Custom titles

Appearance settings expanded
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Chapter formatting
The options are:

e None - chapter and subchapter titles are not formatted at all, use if you want to
define special numbering styles. For example letters: in chapter title type "A First
Chapter", "A.1 Some Subchapter"

e Numbers - chapters and subchapters are numbered (1, 1.1, 1.2, 2, ...)

o Bullets - subchapters are indented and displayed with bullets.

e Indented - subchapters are indented.

Custom titles
If you disallow custom titles, the chapter title will appear as a header at the top of
your content. If you enable custom titles, you will be able to create a title different
from the one that appears in the ToC or display no title at all. If you enable custom

titles, you will need to enter the chapter title as part of the page content.

» Step 6: Adding chapters and subchapters

o Titles of chapters appear as links in the table of contents to the left of your
content. Keep your titles short.

e To add another chapter, click on the + (plus) icon in the Table of Contents or
first chapter. The new chapter will be inserted directly after the chapter whose
title is on the same line as the Red Cross you click (Screenshot 1).

e Note that the sub chapter box is checked. A chapter may have many sub
chapters, but sub chapters cannot have subchapters. In order to keep this
resource simple, you are limited to two levels (Screenshot 2).

e You now see a chapter and a sub chapter. Because we did not elect to number
chapters, the fact that the second chapter is a sub chapter cannot be seen in
the table of contents. Note that you do, however, see this in the title above the
content. By the way, the items in the table of contents are neither numbered
nor are they indented only because that is the option we chose when setting
up the book. We can always go back and change that (Screenshot 3).
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Year 2015

Lea rn Add new chapter Lea rn
Chapter title*
Subchapter,
% 1 January
i 1.1 Week 1
Screenshot 1 Screenshot 2 Screenshot 3

» Step 7: Importing chapters

e Create a zip file of HTML files and optional multimedia files and folders. If you
wish to upload subchapters, add “sub” to the end of HTML file or folder
names.

e Go to Administration > Book administration > Import chapter

e Choose whether each HTML file or folder represents one chapter

e Browse for and select the zip file, either using the Add button or the drag and
drop method

e Then click the import button
Year 2015
Import chapter

Type Each HTML file represents one chapter v

Zip file* Choose a file

~

You can drag and drop files here to add them
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Creating a Lesson

The lesson activity module enables a teacher to deliver content and/or practice activities in
interesting and flexible ways. A teacher can use the lesson to create a linear set of content

pages or instructional activities that offer a variety of paths or options for the learner.

In either case, teachers can choose to increase engagement and ensure understanding by

including a variety of questions, such as multiple choice, matching and short answer.

Depending on the student's choice of answer and how the teacher develops the lesson,
students may progress to the next page, be taken back to a previous page or redirected
down a different path entirely. A lesson may be graded, with the grade recorded in the

gradebook.

¢ Fomeen
% ** Lessons may be used:
e For self-directed learning of a new topic
e For scenarios or simulations/decision-making exercises
o For differentiated revision, with different sets of revision questions depending upon

answers given to initial questions

Step 1: Turn editing on
Step 2: Add an activity or resource

Step 3: Select Lesson

vV V V V

Step 4: Add a name for your Lesson

Adding a new Lesson

General

Name#*
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» Step 5: Appearance settings are collapsed by default

Appearance

o File pop: If you want to include a link to a file on the lesson page for students
to refer to, upload it here.

e Progress bar: Choose this to show a bar at the bottom of the page showing
how far into the lesson the student has got.

e Display ongoing score: Choose this to let students see their score as they
work through the lesson.

e Display left menu: Choose this if you want to show a list of the pages in the
Lesson so a student can see what is coming up.

e Minimum grade to display menu: Choose this if you want the student to go
through the lesson once and get a grade before they can see and navigate
through all the different pages.

e Slideshow: Please note that slideshow mode currently does not work for
Moodle 2

e Maximum Number of Answers: Here you can set the default number of
answer boxes available when you add your question or content pages. For
instance, if you are only going to use True/False, you would only need 2. You
can change this at any time so it’s not crucial.

e Use default feedback: Choose this if you want to show a set phrase

regardless of their answer. If you have set your own default feedback such as
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“well done; correct” or “never mind; better luck next time” etc. it will appear.
If you have not, then Moodle’s default feedback will appear.
e Link to next activity: Choose this to give students a link to another activity

when they reach the end of the lesson.

» Step 6: Availability

Availability
Available from 12 v | January ¥ 2015 « 15 | 30 ~ Enable
Deadline 12 v | January v | 2015 v 15 v |30 ¥ Enable
Time limit (minutes) 20 Enable
Password protected lesson No v
Password Unmask

P} ) WA Save and retum to course
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Creating a Page

The page module enables a teacher to create a web page resource using the text editor. A
page can display text, images, sound, video, web links and embedded code, such as Google
maps. Advantages of using the page module rather than the file module include the
resource being more accessible and easier to update. For large amounts of content, it’s
recorgrrlended that a book is used rather than a page.

& FORGET!

ST

LA
A page may be used to:

Present the terms and conditions of a course or a summary of the course syllabus

e Embed several videos or sound files together with some explanatory text

Step 1: Turn editing on

Step 2: Add an activity or resource

Step 3: Add Page

YV V VY V

Step 4: Add Name and description of page

General

Name*

Description* Show editing tools.

Display description on course page

» Step 5: Add Content

Content

Page content* Fontfamily |v| Fontsize |+ Paragraph |- # %
==Je@mA-2nu
iz & FAo Q=

B 7 U s x x

Path: p

24 |Page

No part of this document may be reproduced or distributed in any form or by any means, or stored in a data base or

retrieval system, without the prior written permission of the Centre for Learning Technologies, Stellenbosch University.




» Step 6: Select Appearance
Choose here whether or not to display the page description along with the page
cntent when a user clicks on the page. If the administrator has allowed both open

and pop-up as display options, you will have additional display settings here.

Appearance

Display page name ¢

Display page description

> Step 7: Save and retum to course Save and display Cancel

25| Page
No part of this document may be reproduced or distributed in any form or by any means, or stored in a data base or

retrieval system, without the prior written permission of the Centre for Learning Technologies, Stellenbosch University.




Database

The database activity module enables participants to create, maintain and search a
collection of entries. The structure of the entries is defined by the teacher as a number of
fields. Field types include checkbox, radio buttons, dropdown menu, text area, URL, picture
and uploaded file. The visual layout of information when listing, viewing or editing database
entries may be controlled by database templates. Database activities may be shared

between courses as pre-sets and a teacher may also import and export database entries.

If the database auto-linking filter is enabled, any entries in a database will be automatically
linked where the words or phrases appear within the course. A teacher can allow comments
on entries. Entries can also be rated by teachers or students (peer evaluation). Ratings can
be aggregated to form a final grade which is recorded in the gradebook.
S0
N Database activities have many uses, such as
e Acollaborative collection of web links, books, book reviews, journal references etc.
o For displaying student-created photos, posters, websites or poems for peer
comment and review
To add a database activity
> Step 1: Turn editing on
> Step 2: Add an activity or resource
» Step 3: Select “Database”
>

Step 4: Give your database a name and a description

Adding a new Database

General
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» Step 5: Select your options

ENTRIES Entries

Approval required No v

Allow comments on entries No v
Entries required for completion None v
Entries required before viewing None

Maximum number of entries None v

e Approval required
If set to "yes", the entry will only be visible once a teacher has checked and approved it.
e Allow comments on entries
If set to "yes", users will be able to comment on database entries.
e Entries required for completion
Will display how many entries you wish the student to add before the activity can be
considered "complete".
e Entries required for viewing
Will display how many entries you wish the student to add before they are allowed to
see entries by other people. Note: If entries are required before viewing, the database
auto-linking filter should be disabled. This is because the database auto-linking filter
can't determine whether a user has submitted the required number of entries.
e Maximum number of entries

Will display the maximum number of entries you wish students to make.

AVAILABILITY

Availability
Available from 12 v | January v|| 2015 v/ 15 v 55 v Enable
Available to 12 v | January v|| 2015 v 15 v 55 v Enable
Read only from 12 v | January v|| 2015 v/ 15 v 55 v Enable
Read only to 12 v | January *|| 2015 *| 15 v || 55 ~ Enable
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e Available from/to
Select here when you want the database to be visible to students.

e Read only from/to
If you wish, select here the dates you want students to be able to see entries in the
database but not be able to add their own. For example you could make a database
'available from' January 1st until March 1st, but 'read only' from January 1st to February
1st. This means students can only view entries for a month before being able to add

their own.

The 'available from/to' settings override the 'read only from/to' settings. So if a
database has 'read only' from 1st January, and "available from" 1st February, students

will not be able to view its content during January.

RATINGS
¢ Roles with permissions to rate
Database entries can be rated using a scale. By default, only teachers can rate database
entries, though students can be given permission to do so if desired from
Administration>Database administration. This is a useful tool for giving students
participation grades. Any ratings given are recorded in the gradebook.
Step 7: Define the fields

Step 8: Define the templates

YV V VYV V

Step 9: Add one or two same entries then edit the templates as appropriate
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File

The file module enables a teacher to provide a file as a course resource. Where possible, the
file will be displayed within the course interface, otherwise students will be prompted to
download it. The file may include supporting files. For e.g. a HTML page may have
embedded images or Flash objects. Note that the students need to have the appropriate
software on their computers in order to open the file.

% FOREET,

Sy

A file may be used:
= To share presentations given in class
= Toinclude a mini website as a course resource
= To provide draft files of certain software programs so students can edit and

submit them for assessment.

> Step 1: Turn editing on
» Step 2: Drag and drop the file onto the course section where you’d like it to appear

» Step 3: If necessary, edit the title of the file by clicking the pencil icon

LONGER METHOD

» Step1l:  Tum editing on

> Step 2: Add an activity or resource
» Step 3: Select File
>

Step 4: Add a name and description for file

General
Name*

Description

Display description on course page

29 |Page
No part of this document may be reproduced or distributed in any form or by any means, or stored in a data base or

retrieval system, without the prior written permission of the Centre for Learning Technologies, Stellenbosch University.




» Step 5: Add content using the +Add icon or drag and drop

Content

Maximum size for new files: Unlimited

Select files

o Fies
~
» Step 6: Select Appearance, choose from the dropdown box what type of display it
should be:
o Automatic - if you want Moodle to sort it out
o Embed - if you want to show the file as part of the Moodle
page
o Force download - if you want to force the user to save the file
o Open - if you want to show the file in the browser, but
without the Moodle page decorations
o Pop-up/New window - if you want it to pop-up or in a new
window
o Inframe —if you want to use a horrible bit of non-strict HTML

that should never be allowed in polite company.

Save and retum to course Save and display Cancel ) Step 7:

FORGET!
o\

Don't Remember that you will be able to Drag and Drop files ONLY if you are using one of the following browsers:
% OI0) Firefox / Chrome / Internet Explorer 10. Should your browser support this feature, you will see this

message above the “select files” box:

Maximum =ize for new files: Unlimited - drag and drop ax-ailat:l&@
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Forum

The forum activity module enables participants to have asynchronous discussions i.e.
discussions that take place over an extended period of time. There are several forum types
to choose from, such as a standard forum where anyone can start a new discussion at any
time; a forum where each student can post exactly one discussion; or a question and answer

forum where students must first post before being able to view other students' posts.
Don't
2 FERGET!
® 0‘
To create a forum:
» Step 1l: Tum editing on
» Step 2: Add an activity or resource

» Step 3: Add forum

» Step 4: Add name and description for forum

- General
Forum name* Forum 1

Dascription*

Display descnption on course page

Forum type /4 Qrun lur general uss v

» Step 5: Select forum type
e Single simple discussion: A single topic discussion developed on the page,

which is useful for short focused discussions.
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e Standard forum: an open forum where anyone can start a new topic at any
time for general use.

e Each person posts one discussion: This is useful when you want each student
to start a discussion about the weeks topic, and everyone else responds to
these forums

e Qand A: Instead of initiating discussions participants pose a question in the
initial post of a discussion. Students may reply with an answer, but they will
not see the replies of the other students to the question in that discussion until
they have themselves replied to the same discussion.

e Standard forum: displayed in a blog-like format

» Step 6: Change the maximum attachment size to 20MB

Attachments and word count

Maximum attachment size 20MB v

N

Maximum number of attachments 9 r

Display word count No r

» Step 7: Select subscription type
e Optional subscription - Participants can choose whether to be subscribed
e Forced subscription - Everyone is subscribed and cannot unsubscribe
e Auto subscription - Everyone is subscribed initially but can choose to
unsubscribe at any time

e Subscription disabled - Subscriptions are not allowed.

» Step 8: Select rating setting (if applicable)

» Step 9: Select groups/release criteria

> Step10
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.~ Don't
. FORGET!

—

CIRC

To prevent or allow students to create new topics:

e Step 1: While in the set-up page for the forum
e Step 2: Go to Settings in left navigation bar
e Step 3: Click on permissions

Forum administration

' Edit settings
Locally assigned roles
Permissions

* Check pt:(l‘ll:b!.‘ﬂ'b\
Fliters

* Logs

' Backup

Restore

Subscription mode

¥ Subscribe to this forum

* Show/edit current subscribers
Course administration

Switch role to

e Step 4: Scroll down the list to allow/restrict student access

e Step 5: Click on the to prevent students from starting new discussions

Start new discussions Student .
mod/forum:startdiscussion
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Glossary

The glossary activity module enables participants to create and maintain a list of definitions,
or to collect and organise resources. A teacher can allow files to be glossary entries. Attached
images are displayed in the entry. Entries can be searched or browsed in different formats.
It can be a collaborative activity or be restricted to entries made by the teacher. Entries can
be put into categories. If the glossary auto-linking filter is enabled, entries will automatically
be linked where the concept words and/or phrases appear within the course.
Don'’t
FORGET!

o

e
To create a book:

Step1:  Tum editing on

Step 2: Add an activity or resource
Step 3: Add Glossary

Step 4: Add Name of introductory chapter

YV V. ¥V VYV V

Step 5: Add Description
General
Mame*

Dezeription®

Display description on course page

Is this glossary glebal?

Glossary type Secondary glossary T
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» Step 6: Select Entries

Entries
Approved by default Yes ¥
Always allow editing No -
Duplicate entries allowed No v
Allow comments on entries No v

Automatically link glossary entries Yes v

o Approved by default:
If set to yes, then new entries appear automatically. If not, then the teacher
must approve each one first.

o Always allow editing
If set to yes, students can edit their entries at any time. If not, then they can
only edit for a certain period.

o Duplicate entries allowed
This allows the entry of more than one definition for a given word.

o Allow comments on entries
Students and teachers can leave comments on glossary definitions. The
comments are available through a link at the bottom of the definition.

o Automatically link glossary entries
If the glossary auto-linking filter is enabled by an administrator, then turning
this on allows individual entries in this glossary to be automatically linked
whenever the concept words and phrases appear throughout the rest of the

same course.
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» Step 7: Select Appearance

Appearance
Display format Simple, dictionary style v
Approval display format Default to same as display format v

Entries shown per page 10
Show alphabet links Yes v
Show 'ALL' link Yes v
Show 'Special’ link Yes v
Allow print view Yes v

o Display format:

Simple, dictionary style — This looks like a conventional dictionary
with separate entries. No authors are shown as links.

Continuous without author — Like the simple style. Shows the entries
one after the other without any kind of separation but the editing
icons, but only if your theme support it, you usually have to modify
the theme if you want an alternative appearance to the simple
setting.

Full with author — A forum-like display format showing author’s data.
Attachments are shown as links.

Full without author — A forum-like display format that does not show
author’s data. Attachments are shown as links.

Encyclopaedia — Like full with author but attached images are shown
inline.

Entry List — This lists the concepts as links.

FAQ - Useful for displaying lists of frequently asked questions. It
automatically appends the words QUESTION and ANSWER in the

concept and definition respectively.

> Step8: cance
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Groups

Why use groups:

You are a teacher in a course where you have several classes and you want to filter
your activities and gradebook so you only see one class at a time.

You are a teacher sharing a course with other teachers and you want to filter your
activities and gradebook so you don’t see the students from your colleagues’ classes.
You want to allocate a particular activity or resource to just one class or set of users

and you don’t want others to see it.

Group levels:

A group or grouping can be used on two levels:

Course level: The group mode defined at the course level is the default mode for all
activities defined within that course. To use groups you need first to set a group
mode in Administration>Course administration>Edit settings

Activity level: Each activity that supports groups can also have its own group mode
defined. If the course setting “Force group mode” is set to “Yes” then the option to
define the group mode for individual activities is not available. If it is set to “No”,

then the teacher may change the group mode:

Groups
Group mode Separate groups ¥
Force group mode No r
Default grouping MNone v

» Step 1: Select the module that you wish to work in

» Step 2: Under Administration (on the left): Select Users and then Groups
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Group modes:
There are 3 group modes:
e No groups: There are no sub groups, everyone is part of one big community.
e Separate groups: Each group can only see their own group, others are invisible.

e Visible groups: Each group works in their own group, but can also see other groups.

Enabling either separate or visible groups on an assignment drop-box enables staff to filter
the student submissions to see only those from a particular tutor group. With visible groups,
students can see which other groups are doing the same activities as they are; with separate

groups, they don’t know which other groups are doing the same activities.

Creating a group

e Click the 'Create group' button in Administration> Course administration > Users >
Groups

e Add a group name and optional description (displayed above the list of group
members on the participants page), enrolment key and picture (displayed on the
participants page and next to forum posts)

e C(lick the 'Save changes' button

e Select the group to which you want to add participants, then click the 'Add/remove
users button

e Inthe "Potential members" list, select the users you want to add to the group.
Multiple users may be selected using the Crtl key.

e Click the Add button to add the users to the group

An optional group ID number may be added for matching the group against external systems.
Group ID numbers are not displayed anywhere on the site. Within a course, all group 1D
numbers must be unique. Which makes it impossible to create a group with a duplicate group

ID number.

38| Page
No part of this document may be reproduced or distributed in any form or by any means, or stored in a data base or

retrieval system, without the prior written permission of the Centre for Learning Technologies, Stellenbosch University.



https://docs.moodle.org/27/en/Enrolment_key

Seneral
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Group 10 number

Group descriphon [T
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Auto-create groups

Groups may be created automatically via the 'Auto-create groups' button in Administration > Course administration >

Users > Groups. To see all the settings, click the Expand all link top right.

Auto-create groups

General
Naming seheme soed
Auto create based an b of 00U
Group mamber csunt
Sroup members
Selestmembers with role  Sadsil v
Allocte members el

Prevent last small aroup

Grouping

General
A naming scheme can be created automatically. # is replaced by sequential numbers, and @
by letters.
For example:
e Group @, will create group with a naming scheme Group A, Group B, Group C
e Group #, will create group with a naming scheme Group 1, Group 2, Group 3
You can specify if you would like to create:
1. x number of Groups or

2. each group contain x number of students
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When selecting Members per group the Prevent last small group will allocate
additional members to an existing group rather than create a new group with fewer

members than x. This setting is found by clicking on the Show More link.

Group members

Select members from allows you to choose from roles or available cohorts. Specify
and Group/Member count work together. The setting 'Select members from cohort'
lists all cohorts which users enrolled on the current course are part of. The number

in brackets is the number of users enrolled on the course in that cohort.

Grouping
Create in grouping and grouping name allows you to create a new grouping and
allocate the new auto-created groups to be created to it. Prior to creating the

groups, you can view the group.

Groups and enrol plugins

Where groups are created automatically with enrol plugins such as IMS Enterprise,
members cannot be unenrolled manually via the groups screen inside a course. This
has to be done from the plugin. Additionally, when group members are owned by a

plugin like this, there is information below their name on the groups screen.

Group’s overview
A overview of groups and groupings is available via the Overview tab

in Administration > Course administration > Users > Groups.
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Labels

The label module enables text and multimedia to be inserted into the course page in
between links to other resources and activities. Labels are very versatile and can help to

improve the appearance of a course if used thoughtfully.

%’ ** | Labels may be used:
e To spilt up a long list of activities with a subheading or an image
e To display an embedded sound file or video directly on the course page

e To add a short description to a course

> Step 1: Turn editing on

> Step 2: ACQ an actuvity or resource
» Step 3: Click on ‘Labels’
» Step 4: Under General type your chosen words or add your resources

Adding a new Label

Sxpand all

General

Label text*

NOTE: Because the label has the text editor, it is possible mot just to type words

but also to add images. Links media or code from within the labels’ editor.
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» Step 5: These settings are collapsed by default. Leave Common Module settings as

“show” for the label to be visible.
Common module settings
Visible Show ¥
Grouping None v

Available for group members only

» Step 6: Restrict access/Activity completion
These settings are visible if Conditional activities and Activity completion have been

enabled in the site and the course.

> Step 7: Save and retum fo course Save and display Cancel
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Messages

Messaging refers both to automatic alerts from Moodle about new forum posts, assignment

submission notifications etc., and also to conversations using the instant messaging feature.

Message Alerts

e Users can receive message alerts from Moodle in a number of ways and for a
number of reasons: users may for instance receive instant messages via
the Messages block; students may be messaged by their course tutor via the People
block; teachers might receive automatic notifications of assignment submissions and
admins might receive notification of problems with the site.

e How these messages and others are received can be set by each user from the
Messaging link in their profile. Check boxes allow the user to select how they wish to
be notified of incoming messages. See Messaging settings for more information.

My profie settings
=

Portfolios

Messaging
Blogs

Badges
Activity reports

Site administration

Search

Instant messaging
If enabled for the site, users in Moodle have the option to send each other messages.
Messages can be sent from the following places:

e as admin in Bulk user actions

e as ateacher from the People block

e asany logged in user from the Messages block or Online Users block

e asany logged in user by clicking on the profile of another user (if admin has allowed

profiles to be viewed)
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Moodle Mobile App

Moodle Mobile is the official mobile app for Moodle. It allows you to browse the content of
your courses, even when offline. You receive instant notifications of messages and other
events. You can search and contact other people in your course quickly. Moodle Mobile

allows you to upload images, audio clips, videos and other files from your mobile device.

(left-Android and right-iOS)

» Step 1: Download Moodle Mobile (MM) from one of the following:

eee: odacom 40 © A8 AM o -

Categories Featured
= Googleplay $ ﬁ
MATTHEW MOLE'S |
e

Best New Apps
New & Updated Games

Hearthston § Implosion— # Splash:
e Heroes of Never Lose Underwater
Most Popular Games Ea
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» Step 3: In the search field type in: Moodle Mobile:

008 dmien 4G & N S
L woedie matle s O
€ moodle mobile \!1
Moo Mctee
Apps WORE Vetwe Py —
Moodle Mobile i
Maodla Py Ltd,
ThR A H
B IRSTALLED
MDrofd - Moodle mobile app H
cloture. tpace
i I n HhRh
FREE
Books s
Moodle for Mobile Learning
Wark Aberdour
PSS Aol sl
Moodle 2 Administration
Flex Buchner
dededee
P39 RSB0

P ) 2arAM % -
% moodie moble e ©

Moodle Mobile

Moodle Pty Ltd,

2900

Owwrloads 200 Cucation rdm

Improve how you 8ccess your Moodle
courses with this official helper app

C—C—
Bl s £ 82

» Step 5: Then click ‘Open’ to open up Moodle Mobile:

sesssicdacom 4G 948 AM so% WD
2 moodie mobile 51 Resuits @
Moodle Mobile [open]
Moodle Pty Lid ooy 4

Moodle Mobile
Moodle Pty Ltd,
[ UNINSTALL ‘
Downloads 28872 Educaton Similar

Improve how you access your Moodle
courses with this official helper app

WHAT'S NEW

New features:

- Teachers can view student’s assignment
submissions (both #{ies and enline~text) online
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» Step 6: Type in the site URL — http://www.learn.sun.ac.za and then click ‘Add’:

http://learn.sun.ac.za

Ican'tlogin Manage accounts

L1 (2] 3]sl ]e]l7]s]o]0)
allwlelrft]yllulifolp]
(alsfd)lffofnlifk]!]
1zl xclv]binimfie
smief i J Jeol

» Step 7: You need to log in to the site in a browser window, click yes:

You need to log in to the site in a browser
window.
You need to log in to the site in a
browser window.

» Step 8: Fill in your Username and Password:

ases yedacom 4G v 949 AM o -

& sso-prod.sun.ac.za <

O ‘ Bl //sso-pred.sun.ac.za/c | ]

E s 30SCH
UNIVERSITEIT q NIVERSITY
STELLENBOSCH

& UNIVERSITY

Single Sign-on
Single Sign-on
Usornamo:
taiq.
Username:
Password:
Hsername
S sonsanne
Password:
Password
o Kiiok hior vir Afrikaans
wy Kliek hier vir Afrikaans & Information
« You ware rediractad hare to
identify yourself using your
Information network credentials.
© « Single Sign-On (SSO) is the
los
= You were redirected here to Sysiem which m"d‘“ymj'
identify yourself using your Il Iﬂ _J'_
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http://www.learn.sun.ac.za/

» Step 9: This is the Moodle Mobile homepage:

Motifications
Notifications

1 &

Messages
d Upload

Uplead

Calendar evenls

Calendar events My files

My courses

My files

Website
My courses
Help
Website

Sattings

+t # 6 0 O F E P

Help

Logout

Settings

&
B
-
o
(]
@
&
-

Logout

47 |Page
No part of this document may be reproduced or distributed in any form or by any means, or stored in a data base or
retrieval system, without the prior written permission of the Centre for Learning Technologies, Stellenbosch University.

# Sentrum vir Leertegnologieé
: Centre for Learning Technologies
iZiko lokuFunda ezobuGcisa



Profile Settings

Moodle provides you with a personal profile that applies to all the
Moodle subjects you are enrolled in. You can edit your profile
information at any time. You can choose to hide or display your email

address, include a photo or an avatar, or add a link to your website.

Go to My home page and in the Settings block, click ‘My profile
settings’ (to display dropdown menu) then ‘edit profile’.
» Editing Your Profile

Administrators can update user profiles via Administration > Users >

Wy hame My courses

Learn

My home
Site hame
SUNLearn
My profile
My courses

2014

Wy profile settings
Edit profile \
Roles
Partfolios
Messaging
Blogs
Badges
Activity reparts

site administration

Search

Accounts > Add a new user or Browse list of users and individual users may update their

profiles by choosing the Edit profile link from Settings> my profile settings. The fields are

divided into 3 sections - General, Picture & Optional which are all explained below. Note

that some settings are 'advanced’, so you may need to click the 'Show Advanced' button on

the right to see all the settings. The advanced settings are indicated below. Remember to

click 'Update profile' when you have finished.

> General

The first section contains fields that must be completed:

e First name & Surname: These are self-explanatory. These names will identify you

everywhere in your Moodle courses.

e Email address: The email address should be an address that you check regularly. It is

used for acknowledgements and announcements from Moodle, including messages

from Forums that you are subscribed to. It is also the address that is displayed to

other users of Moodle, depending on your 'Email display' setting (below).

e Email display: This controls the visibility of your email address to others. The three

settings are self-explanatory but please note 'Hide my email address from everyone'

only hides it from students. Teaching staff and other staff with editing access will

always be able to see your email address.
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e Email format: There are two formats: "Pretty HTML format" (messages will be
formatted) and "Plain text format" (plain text with no formatting).

e Email digest type: This setting determines how you receive any posts from Forums
to which you are subscribed, allowing you to receive messages individually or on a
daily basis.

e Forum auto-subscribe: This setting lets you decide if you want email copies of posts
that are added to forums. If you set this to subscribe, the system will automatically
email you copies of new posts in forums that you post in, unless you manually
override it when posting.

e Forum tracking: Enabling forum tracking means highlighting the posts you have not
read yet, which should improve your forum navigation.

e When editing text: This can usually be left on "Use HTML editor (some browsers
only)". This allows for text formatting options, but requires newer browsers. If you
find your browser is not letting you edit text, change this setting to "Use standard
web forms".

e City/town & Country: Add your location.

e Timezone: This field is used to convert time-related messages on the system (such as
assignment deadlines) from the local timezone (the time in London) to the correct
time in whichever zone you have selected.

e Preferred language and theme: You can view Moodle in several different languages
and colour themes, which you can select via these two options. Note: changing the
preferred language only affects the Moodle interface, not the course content.

e Description: In this field you can enter some text about yourself, be it information

about your studies, hobbies, qualifications or anything else.

» User picture
e This section is optional and allows you to choose your own profile picture. Your

current picture is shown, if you have already chosen one.
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(Note: If the admin has enabled it in Settings > Site Administration > Users > Permissions > User policies, a
gravatar you might have attached to your email account will appear as your profile image if you don't upload a

different one.)
e New picture

The "Choose a file" button allows you to choose a new picture for your profile. The
picture must be in JPG or PNG format (ie the names will usually end in .jpg or .png).
To upload an image, click the "Upload a file" button from the list in the File picker,
and select the image from your hard disk.

(NOTE: Make sure that the file is not larger than the maximum size listed, or it will not be uploaded.)
Then click "Update Profile" at the bottom - the image file will be cropped to a square
and resized down to 100x100 pixels. When you are taken back to your profile page,
the image might not appear to have changed. If this is so, just use the "Reload"

button in your browser.

> Interests

e Use tags here to display your interests on your profile page.

» Optional
e There are several optional fields (all advanced) allowing you to add further details to
your profile such as contact details and your website.
» Custom Profile Categories
e |f any custom user profile categories and fields have been created on your Moodle

site, they will be listed at the bottom of the Admin >Accounts>User profile fields

» Updating a user profile
e Users with the capability Moodle/user: update are able to update another user's
profile i.e. in addition to being able to edit the profile, all settings (username,
password, authentication method, force new password etc.) may be changed.
» Account disabling
e An account may be disabled by setting the authentication method to "No login". The
account email may not be used to create another account.
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Questionnaire

The questionnaire module allows you to construct surveys using a variety of question types,

for the purpose of gathering data from users.

Phase 1: Settings
Click on the following:

> Step1:  Turmn editing on

> Step 2: Add an activity or resource
» Step 3: Select Questionnaire
>

Step 4: Add name and description
7 Adding a new Questionnaire

Expand all
General

Name*

Description

Display description on course page

» Step 5: Select the dates when your questionnaire should open and close
Timing
Use Open Date 15 v | January Y 2015 v| 14 v 05 ~

Use Close Date 15 v | January Y 2015 v| 14 v 05 ~

» Step 6: Response options need to be selected — each option under this section has a

, Which explains what your selection could be.

S

éﬂg’;ﬂ e Respondents viewing all responses refers to ONLY their own responses
)
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e Branching options = you can create sub-questions, e.g. if a student

responds “yes” to a particular question, they can be directed to a question

used to clarify their answer, answering “no” takes them on to the next

default question in the questionnaire.

Response options

Type
Respondent Type

Students can view ALL responses

Save/Resume answers

respond many ¥

fullname v

After answering the questionnaire v

No »

Allow branching questions No r

Auto numbering Auto number pages and guestions v

Submission grade No grade v

> Step 7: For “Content Options” select = ©'®3t® nev

for your questionnaire.
*Do not make your questionnaire public, as this is then accessible to all SU staff members, registered on the system*

» Step 8: If you have groups in your module, you can allocate your questionnaire to a
specific group under common module settings.

» Step 9: Restrict access as needed.

» Step 10:

Phase 2: Adding questions

» Step1l: Add questions

» Step 2: Most question types are self-explanatory:

a. Radio buttons
Watter aspek was vir jou die van die grootste belang t.o.v. die module: / Which aspect was the most important to you with regard to this module:

Persoonlike belang / Personal interest

Om te slaag / To pass

Toepassingsvaardigheid / Application skills

Bedryf of werkgewerbehoeftes ¢ Industry or employee needs
NAVT. /T NA.
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b. Text boxes

How do you feel about the scope of the exam?
(Important setting for Text boxes is to have enough space for the answer, do
this by entering the number in the “Text length” box in the setting.)

¢. Branching questions:

Cluestion Mame

atmasphere
Response is reguired Yes® No
Question Text* Font family |~ || Font size ~|| Paragraph |~
B I U ax x| EEE JF2E®| L
== iE ¥ Ao 2 o

Did you enjoy the class atmosphera?
e Create a multiple choice question (Radio buttons / Check boxes /

Dropdown box / Yes-No
e Create your next question

e Parent question must be selected

Farent Question atmosphere-=MNo v

Choose
atmosphere

atmosphere-=Yes

¢ In this example, a selection of No in the first question will lead the

respondent to the next question. A selection of Yes, will mean the

respondent will NOT see the second question.
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d. Rating scale can be set up in two ways.

Option 1: (Settings below)

[

Normal v

Choose v

Font famity = | Fontsze ~|| Paragraph |~ | #ALO
BJUmx. x EES|FuindsA-2-mn

iE * FAJER 2 /[
On a scale of 1-5 (1 = not confident, 5=very confident), how confident are
wou that you understand the topics discussed in class?

Path p

Cognitive theory
Approaches to leaming
Behaviourism
Self-determination

Option 2: (settings below)

How confident are you that you understand the topics discussed in class?

Cognitive theory
Approaches to learning
Behaviourism
Self-determination

Mot confident Slightly confident Confident

Font famity |~ || Fontsize = || Paragraph - || "} R IRE]
B JUMmx x ESEE Jeo@mdm A-%- a0
== - E ® i Jokl 52 4 e

How confident are you that you understand the topics discussed in class?

Path: p

1=Not confident

2=Slightly confident
J=Confident

4=5lightly more than confident
5=Very confident

Cognitive theory

Approaches to leamning
Behaviourism
Self-determination

Slightly more than
confident
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Don't,
FORGET!
~=
L)

The number, (=) sign and column title in Option 2 have NO spaces between them.

Step 3: Retrieving responses
Once a questionnaire has been completed by your target audience, you can retrieve the
responses.

e Click on the questionnaire, then click on: Al responses [8)

e Responses will by default be viewed graphically first
e You can download responses Download in text format

(Copy and paste from the downloaded document into excel if this is your preference)

4 In hoe 'n mate was die werkswinkel as geheel sinvol vir u betrokkenheid as dosent by leer en onderrig?

To what extent was the workshop as a whole meaningful for your invelvement as lecturer in leaming and teaching?

Response Average

letwat / Somewhat - 12%

Groot bydrae gemaak / Very usefull — 2%

Onontbeerlik 7 Indispensable - 25%

Total — 100%
5 Wat was vir u die mees nuttige aspek van hierdie werkswinkel?

What aspect of this workshop did you find most useful?

Response

Course was very

course was enriching and i have leamed what i need to know Facilitator was very helpful and have covered what is essential and required

Quizzes

Understanding the interface SUNLeam and how to change/ edit names.

e Select: Show nonrespondents

e Send a reminder message to complete the questionnaire
e Even if the questionnaire responses are anonymous, non-respondents are ALL those

enrolled in the module who did not yet completed the questionnaire.

o ="
J Terugvoer_oor_Werkswinkel_Feedback_on_Weorkshop - Notepad _

File Edit Format Wiew Help

Response Submitted on: Institution Department Course Grou? Il
2360 26/03/2014 15:30:55% Institute Plant Biotechnology Facilitate
2362 26/03/2014 15:34:32 UNIVERSITY OF STELLENBOSCH THERMODYNAMICS Fi
2806 02/04,/2014 16:032:17 Facilitator Training Course

2807 02/04/2014 16:03:00 Facilitator Training Course

2808 02/04/2014 16:03:05% Facilitator Training Course

2809 02/04/2014 16:04:42 Facilitator Training Course

2810 02/04,/2014 16:06:12 stellenbosch University visual arts Facilitate
3597 23/04/2014 15:13:22 Facilitator Training Course
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Quiz
The quiz activity enables a teacher to create quizzes comprising questions of various types,
including multiple choice, matching, short-answer and numerical. A quiz can be attempted

multiple times, with the question shuffled or randomly selected from the questionbank.

Time limits can be set.

Each attempt is marked automatically, with the exception of essay questions, and the grade
is recorded in the gradebook. The teacher can choose when and if hints, feedback and
correct answers are shown to students.
& ngaén
V06
Quizzes may be used:
e As course exams
e As mini tests for reading assignments or at the end of a topic
e As exams practice using questions from past exams
e To deliver immediate feedback about performance
e For self-assessment
Step 1:  Tum editing on

Step 2: Add an activity or resource

Step 3: Add Quiz

YV V V V

Step 4: Add name and description to quiz

/| Adding a new Quiz

Expand all
General

Name*

Description

Display description on course page
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» Step 5: Set a time limit and enable the dates for the opening and closing of the quiz.
Timing
Open the quiz 14 v January v |2015 v 09 v | 51 ¥ Enable
Closethequiz 14 v  January v|2015 v 09 v |51 v Enable

Time limit 0 minuies ¥ Enable

When time expires Open attempts are submitted automatically

Submission grace period 1 days v Enable

> Step 6: Select Grade

e Grade category
If you have categories in your gradebook, select the one you wish the quiz to be in
here.

e Attempts allowed
Students may be allowed to have multiple attempts at a quiz. This can help make
the process of taking the quiz more of an educational activity rather than simply
an assessment. If the quiz is randomized then the student will get a new version
for each attempt. This is useful for practice purposes.

e Note:
You can change the allowed number of attempts for different groups or users in
the Group or User override sections of the Quiz Administration settings block.

e Grading method
When multiple attempts are allowed, there are different ways you can use the
grades to calculate the student's final grade for the quiz.
- Highest grade - the final grade is the highest grade in any attempt
- Average grade - the final grade is the average grade of all attempts
- First grade - the final grade is the grade earned on the first attempt

- Last grade - the final grade is the grade earned on the most recent attempt only

» Step 7: Select Layout
e Question order
If 'Shuffled randomly' is selected, then the order of questions in the quiz will

be randomly shuffled each time a student starts a new attempt at the quiz.
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The intention is to make it a little harder for students to copy from each
other.

e New page
For longer quizzes it makes sense to stretch the quiz over several pages by
limiting the number of questions per page. When adding questions to the
quiz, page breaks will automatically be inserted according to the setting you
choose here. However, you will also be able to move page breaks around by
hand later on the editing page.

e Note:
Changing this setting has no effect on questions you have already added to
the quiz. The setting will only apply to questions you add subsequently. To
change the page breaks in an existing quiz, you need to go to the quiz editing
screen, tick the 'Show page breaks' checkbox, then use the repaginate
control.

¢ Navigation method
By choosing Sequential instead of Free, the teacher is forcing the student to
progress through the questions in order without being able to go back to a

previous question or skip to a later one.
Layout

Question order As shown on the edit screen v
New page Every question v
Navigation method Free v

Show less
» Step 8: Select question behaviour
e Shuffle within questions
If set to 'yes', then each time the student takes a quiz the parts of the
qguestion will be shuffled randomly.
e Each attempt builds on the last

If multiple attempts are allowed and this setting is set to Yes, then each new
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attempt contains the results of the previous attempt. This allows the student
on the new attempt to concentrate on just those questions that were
answered incorrectly on the previous attempt. If this option is chosen then
each attempt by a particular student uses the same questions in the same
order, independent of randomization settings. To show a fresh quiz on every

attempt, select No for this setting

» Step 9: Select Review options

This section controls what information students will be shown when they review

their past attempts at the quiz, and during the attempt in adaptive mode. It is a

matrix with check boxes.

The various pieces of information that can be controlled are:

The attempt

Will show how the student responded to each question.

Whether correct

Displays whether the students response to each question is correct or incorrect.
Marks

Reveals the marks awarded to the student and the grade for the quiz.

Specific feedback

Will show the feedback for the response to the answer as set when adding the
guestion to the quiz. Each response to a question can have feedback for both
correct and incorrect answers.

General feedback

Displays the general feedback for the whole question as set when adding the
guestion to the quiz. You can use the general feedback to give students some
background to what knowledge the question was testing.

Right answer

Reveals the correct answer to each question, whether the student answered

correctly or not.
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Overall feedback

Displays feedback for the entire quiz as set in the quiz settings.

For each of the above items, you can determine the timeframe when the
students will see them:

During the attempt

Is only available when ‘How questions behave’ has been set to immediate
feedback’, Immediate feedback with CBM’ and ‘Interactive with multiple tries’. If
set to one of these options then a ‘Check’ button will appear below the answer
and when clicked the student will submit that response and then receive
immediate feedback.

Immediately after the attempt

Within 2 minutes of the student clicking "submit all and finish".

Later, while the quiz is still open

After 2 minutes, but before the close date (if the quiz does not have a close date,
this phase never ends).

After the quiz is closed

means what it says (you never get here for quizzes without a close date).

» Step 10: This section controls what information students will be shown when they

review their past attempts at the quiz, and during the attempt in adaptive mode.

The attempt: Will show how the student responded to each question.
Whether correct: Displays whether the students response to each question is
correct or incorrect.

Marks: Reveals the marks awarded to the student and the grade for the quiz.
Specific feedback: Will show the feedback for the response to the answer as
set when adding the question to the quiz. Each response to a question can

have feedback for both correct and incorrect answers.
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e General feedback: Displays the general feedback for the whole question as set
when adding the question to the quiz. You can use the general feedback to give
students some background to what knowledge the question was testing.

e Right answer: Reveals the correct answer to each question, whether the
student answered correctly or not.

e Overall feedback: Displays feedback for the entire quiz as set in the quiz

settings

Review options

During the attempt Immediately after the attempt Later, while the quiz is still open  After the quiz is closed
The attempt ¥ The attempt ¥ The attempt ¥ The attempt
Whether correct ¥ Whether correct # Whether correct «  Whether correct
Marks ¥ Marks #  Marks «  Marks
Specific feedback ¥ Specific feedback # Specific feedback ¥ Specific feedback
General feedback ¥ General feedback ¥ General feedback ¥ General feedback
Right answer ¥ Right answer # Right answer ¥ Right answer
Overall feedback ¥ Overall feedback # Overall feedback ¥ Overall feedback

» Step 11: Restrict access as needed

» Step 13: Edit quiz
Quiz 1

Quiz 1

Altempts allowed: 1

No questions have been added yet

Edit quiz '\.

Back to the course

» Step 14: Add questions

Editing quiz Order and paging

QUESTION BANK
CONTENTS [SHOW
Editing quiz: Quiz 1 The basic ideas of quiz-making

Total of marks: 0.00 | Questions: 0 | This quiz is open

Maximum grade: | 10.00

Save

Page 1 Empty page

Add a guestion ... Add a random guestion ...

Add page here

> Step15:
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SCORM

A SCORM package is a collection of flies which are packaged according to an agreed
standard for learning objects. The SCORM activity module enables SCORM or AICC packages
to be uploaded as a zip file and added to a course. Content is usually displayed over several
pages, with navigation between the pages. There are various options for displaying content
in a pop-up window, with a table of contents, with navigation buttons etc. SCORM activities
generally include questions, with grades being recorded in the gradebook.

L)

. et SCORM activities may be used for
@ e Presenting multimedia content and animations
e An assessment too
» Step 1:  Tum editing on
» Step 2: Drag and drop the SCORM package zip file onto the course section where
you would like it to appear.
» Step 3: Answer ‘Add a SCORM package’ to the popup dialogue asking what you
want to do with the zip file then click the upload button.
» Step 4: Edit the title of the file by clicking the pencil icon, or edit other options by
clicking the editing icon

OR

> Step 1: Turn editing on

> Step 2: Add an activity or resource

» Step 3: Add SCORM package

» Step 4: Enter a name and description

&' Adding a new SCORM package

General
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» Step 5: Either drag and drop a SCORM package zip file into the box with an arrow or
click the Add button to open the File picker menu in order to choose a file from

your computer or a repository
Package

Maximum size for new files: Unlimited, maximum aftachments: 1

Package file

¢

u can drag and drop files here to-add therr

Auto-update frequency Never

» Step 4: Select display and other options as required

» Step 5: Select Package
This setting determines which SCORM package is used by this SCORM activity. Drag
and drop or click the icon top left to upload your SCORM package. The default (1) is
to be able to upload a file. If your admin has added additional options in
Site administration>Plugins>Activity modules> SCORM package then these will be

available in a dropdown menu.

Package
(1_’ f‘{/,l Type

Aute-update frequency
URL

Package file

» Step 6: Alias/Shortcut
If you access your SCORM package from a repository you can choose to create an
alias/shortcut to it and then set an update frequency to set how often Moodle
should check to see if there is an updated zip.
» Step 7: Appearance
e Display package
Choose from current or new window. Note that if you choose a new window,

students need to ensure pop ups are enabled.
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e Display course structure on entry page
If this is enabled then the table of contents of the package will be displayed
when the students clicks to access the package.

e Display attempt status
You can choose whether to display a summary of the student's attempts on
the entry page, on their My home page or both. This setting is helpful when
debugging grading issues - working out why a user got a certain grade.

» Step 8: Availability

Availability
Available from 12 v February v 2015 v 15 v OO0 v Enatle

Availableto | 12 v | February v 2015 v 15 v 00 v Enable

Select the dates you wish the SCORM package to be available to students.

» Step 9: Grade
Grade

Grading method Highest grade r

Maximum grade 00w

e Grading method

1. Learning Objects - This mode shows the number of completed/passed
Learning Objects for the activity. The max value is the number of Package's
Learning Objects.

2. Highest grade - The grade page will display the highest score obtained by
users in all passed Learning Objects.

3. Average grade - If you choose this mode Moodle will calculate the average
of all scores.

4. Sum grade - With this mode all the scores will be added.
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https://docs.moodle.org/27/en/My_home

e Maximum grade
Not applicable if Grading Method is Learning objects. Usual setting is 100.
If your SCO's high score is something other than 100, you should adjust
this value appropriately. When grading Method is one of the score
settings, then the gradebook grade is package score divided by this
number.

» Step 10: Attempts Management

Attempts management

Number of attempts Unlimited attempts  +
Attempts grading Highest attempt
Force new attempt Noo v
Lock after final attempt Mo v

e Number of attempts
Defines the number of attempts permitted to users. It works only with SCORM
1.2 and AICC packages. SCORM2004 has its own max attempts definition.

1. The option to start a new attempt is provided by a checkbox above
the Enter button on the content structure page, so be sure you're providing
access to that page if you want to allow more than one attempt.

2. An attempt is not complete until the cmi. core. lesson status for the attempt
is set to either 'completed' or 'passed'. After that, the Start new attempt
checkbox is available to the learner.

e Attempts grading
When you permit multiple attempts for students, you can choose how to
record the result in gradebook by first, last, average or highest settings.

1. Display attempt status - If enabled, scores and grades for attempts are
displayed on the SCORM outline page. This setting makes the block display
more info to the user on the entry page to the SCORM and in the course

overview block - if you turn it off it will display less info. This setting is
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helpful when debugging grading issues - working out why a user got a
certain grade.
e Force new attempt
If this is enabled then every time the student accesses the package, it will
count as a new attempt.
e Lock after final attempt
If this is enabled then once a student has used up all their attempts, they can

no longer access the SCORM package.
» Step 11: Compatibility Settings
Compatibility settings

Force completed Mo v

Auto-continue Mo v

e Auto-Continue
For SCORM packages that contain multiple learning objects (or SCO's) and
Auto-continue is set to Yes, when a Learning Object calls the "close
communication" method the next available object is launched automatically. If
it is set to No, the users must use the navigation provided to continue to the
next object. Many SCORM packages only contain a single learning object (or
SCO) so this setting does not apply.

e Force completed
If this is enabled then the status of the current attempt is set to "complete".
Note that this only applies to SCORM 1.2 packages and is useful if the SCORM
package does not handle revisiting an attempt correctly, in review or browse

mode, or otherwise incorrectly issues the completion status.
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» Step 12: Common Module Settings
» Common module settings
Visible | Show v
ID number
Grouping Mong v

Available for group members only

» Step 13: Restrict Access

Restrict access

Access restrictions Mone
Add restriction. ..

» Step 14: Activity Completion

Activity completion

Completion tracking Sturdents can manually mark the activity as completed v
Require view Student must view this activity to complete it
Require grade Stutent must receive a grade to complete this activiey
Require minimum score 0 Disable
Require status Passed
Completed
Expect completed on 12 v | February v 2015 v Enahle

+ step 15
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Turnitin Assignment 2

Creates a Turnitin Moodle Direct assignment which links an activity in Moodle to an
assignment/assignments on Turnitin. Once linked, the activity allows instructors to assess
and provide feedback for student’s written work using the assessment tools available within

Turnitin’s Document Viewer.

Step1:  Tumn editing on
Step 2: Add an activity or resource

Step 3: Select Turnitin Assignment 2

YV V VYV V

Step 4: Add name and summary of assignment

General

Turnitin Assignment Name*

Summary* Show editing tools

Display description on course page
» Step 5: Change Submission Type to
Submission Type#* File Upload v
» Step 6: Change Maximum File Size to

Maximum File Size 20MB v

» Step 7: Include the due date

> Step 8: Save and retum to course Save and display Cancel
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Uploading a Folder

The folder module enables a teacher to display a number of related files inside a single
folder, reducing scrolling on the course page. A zipped folder may be uploaded and

unzipped for display, or an empty folder created and files uploaded into it.

& FéJSEET!
% L)
A folder may be used for:

e Aseries of files

e To provide a shared uploading space for teachers on the course page.

» Step 1:  Tum editing on

» Step 2: Drag and drop the folder onto the course section where you would like it to
appear.

» Step 3: Click the button of the action you would like to take with the folder and
click “Upload”

» Step 4: If necessary, edit the title of the folder by clicking the pencil icon.

OR

> Stepl:  Tum editing on

> Step 2: Add an activity or resource

» Step 3: Add folder

» Step 4: Add folder name and description

General

Name*

Description*® Shew editing tools

Display description on course page
» Step 5: Select Content
Either drag and drop a zipped/compressed folder into the box with an arrow or
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click the Add button to open the File picker menu in order to choose a file from

your computer or a repository.
Content

Maximum size for new files: Unlimited

Files

+ 1 Add.. +8 Create folder = =

|l Files

]

You can drag and drop files here to add them

OR

» Step 1:  Tum editing on

» Step 2: Add an activity or resource

» Step 3: Add name and description

» Step 4: Click “Create folder”, choose a name for your new folder and then click
“Create folder”

» Step 5: Click INTO the folder

» Step 6: You can then add individual files into the folder either by dragging and
dropping into the box or clicking the “Add” button to upload files from the file
picker

» Step 7: Choose how you want to display your folder contents, your Common

module settings and if enabled, Conditional activities settings

P Rl Save and retum to course
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|1 Adding & new Filed

General

Marme® |
DESEEN | fortfapaby - Foctese o Parmsrash R |
Brlax, v Enm SimbA-¥-n

= = - Ll - BT e e -

Pathe p
Qisplay deswipbonon |
courss gage
Cantent

Seled lies

ng ard deop hims ~ere 0 add them

conety, e Individual items CANNOT be hidden in a folder

O
MO ¢ Remember that you will be able to Drag and Drop files ONLY if you are using

one of the following browsers: Firefox / Chrome / Internet Explorer 10.
Should your browser support this feature, you will see this message above the

“select files” box:

Maximum =ize for new files: Unlimited - drag and drop ax-ailat:le@ |
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URL

The URL module enables a teacher to provide a web link as a course resource. Anything that
is freely available online, such as documents or images, can be linked to; the URL doesn’t
have to be the home page of a website. The URL of a particular web page may be copied
and pasted or a teacher can use the file picker and choose a link from a repository such as

Flickr, YouTube or Wikimedia.

There are a number of display options for the URL, such as embedded or opening in a new
window and advanced options for passing information, such as a student's name, to the URL

if required.

X FSEE:T!
Note that URLs can also be added to any other resource or activity type through the text editor.

Step 1:  Tum editing on
Step 2: Add an activity or resource

Step 3: Select URL

YV V. VY V

Step 4: Add a name and description for file

Adding a new URL

General

Name*

Descnption

Display deseription on course page

» Step 5: Select Content
Either enter the URL in the external URL field or click the “choose a link” button to

open the file picker and choose a URL YouTube, Picasa etc.
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» Step 6: Select Appearance
Appearance

Display Automatic v
Pop-up width (in pixels) 620
Pop-up height (in pixels) 1000

Display URL description ¥
» Step 7: Select Display

e Automatic - Make the best guess at what should happen (probably what is
wanted 99% of the time).

e Embed - Show the Moodle page with heading, blocks and footer. Show the
title/description of the item and display the file directly in the page as well

e Open - No Moodle heading, blocks, footer or description - just show the file
in the web browser (e.g. shows image, PDF, flash animation, taking up the
whole browser window)

e In pop-up - Same as 'Open’, but opens a new browser window to show this
file (without the Moodle heading, blocks, etc.) - this browser window also

does not have all the menus in it.

> Step 8: Save and retumn to course Save and display Cancel
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Wiki
The wiki activity module enables participants to add and edit a collection of web pages. A
wiki can be collaborative, with everyone being able to edit it, or individual, where everyone

has their own wiki which only they can edit. A history of previous versions of each page in

the wiki is kept, listing the edits made by each participant.

FORGET]
@ LR
Wikis have many uses, such as:

For group lecture notes or study guides

For members of a faculty to plan a scheme of work or meeting agenda together

For students to collaboratively author an online nook, creating content on a topic set

by their tutor.

For collaboratively storytelling or poetry creation, where each participant writes a

line or verse

As a personal journal for examination notes or revision

Step 1: Tym editing on
Step 2: Add an activity or resource

Step 3: Select “Wiki”

YV V VYV VY

Step 4: In an existing wiki, the wiki can be found in Administration>Wiki
Administration>Edit settings.

» Step 5: Add a name and description to you wiki

45 Adding a new Wiki
Expand all

General
Wiki name*

Description*

Display description on course page

WIKI mode

.

First page name
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Wiki Mode
e Choose between ‘individual wiki’ where each student gets their own, or

‘collaborative wiki’ where students work together on a single wiki.

Firs page name
e The name you add here will form the first page of your new wiki. It is a

required field and once a name has been entered, it can be changed.
» Step 6: Select Format

Default Format
» Set the default type of editing your wiki will use. Choose from:
e HTML — editing using the normal text editor
e Creole —a popular wiki editing language.

e NWiki—a wiki editing language used in the contributed NWiki module

Force Format
» If you check this box then students cannot choose their own method of
editing the wiki.
Format
Default format HTML *

Force format

P YAl Save and return to course Save and display Cancel
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Workshop

The workshop activity module enables the collection, review and peer assessment of
students’ work. Students can submit any digital content, such as word-processed documents
or spreadsheets and can also type text directly into a field using the text editor. Submissions
are assessed using a multi-criteria assessment form defined by the teacher. The process of
peer assessment and understanding the assessment and undertaking the assessment form
can be practised in advance with example submissions provided by the teacher, together

with a reference assessment.

Students are given the opportunity to assess one or more of their peers’ submissions.
Submissions and reviewers may be anonymous if required. Students obtain two grades in a
workshop activity — a grade for their submission and a grade for their assessment of their

peers’ submissions. Both grades are recorded in the gradebook.

> Step1:  Tum editing on
> Step 2: Add an activity or resource
» Step 3: Add Workshop

» Step 4: Add name and description
% Adding a new Workshop

General

Workshop name*

Description Show editing tools

Display description on course page
» Step 5: Select Grade settings
Grading Strategy
This determines the assessment form students will use and also the strategy for
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grading submissions. For more detailed descriptions see Grading Strategies. Note:
Grading strategies can't be changed once we have entered the submission phase of a
workshop.
e Accumulative grading: Comments and a grade are given regarding the
aspects of the workshop specified.
e Comments: Comments are given but no grade can be given to the specified
aspects
e Number of Errors: A yes/no assessment is used and comments are given for
specified assertions
e Rubric: A level assessment is given regarding specified criteria
Grade for Submission
This sets the maximum grade a student can attain from a teacher for a given
submission. It is scaled between 0-100
Grade for Assessment
Sets the maximum grade a student can receive for assessing other students’ work. It

is also scaled between 0-100.

(The student will be given a grade here based on his/her accuracy in grading. The system determines what the
average range of marks were for the submissions. Each student is then given a grade to demonstrate his/her
alignment with the average range of marks. For example, the average grades are 75, 66, 80... Johnny gives his
classmate a mark of 40. The system will then penalise Johnny for giving a grade which is outside of the average
range, i.e. his final mark will be lowered. As a lecturer, you are encouraged to look at those marks that the

system has flagged in this way and override the grade if you feel it is needed.)

Decimal places in grade

Decide here how many decimal places are allowed in the grade.
Grading settings

Grading strategy Accumulative grading ¥
Grade for submission 80 v Uncategorised v
Grade for assessment 20 v Uncategorised v

Decimal places in grades o
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» Step 6: Select Submission settings
Instructions for submission
Explain here what students must submit.
Maximum number of submission attachments
If you wish students to attach files, select how many here, up to a maximum of 7. If
you leave it at 0 then they can only enter text.
Maximum File Size

Select the maximum file size: 20MB

Submission settings

Instructions for submission | |Fontfamily |=| Fontsize  |-| Paragraph |~ L Rl=]
& G A - -

B 7 U #&#X x| EEE
=EiE % FJo® 2 |

4

Path: p

A

Maximum number of submission 1T
attachments

Maximum submission aftachment size | 20MB .
Late Submissions

Ticking this box will allow students to submit after the deadline. Once the workshop
has been made we can then set more settings relating to submissions. This is done
through clicking on the menu highlighted below which is found when you click on
the workshop’s link or after clicking “Save and Display” on completion of the
workshop. To access the menu simply click on “Allocate Submissions”. It is

highlighted in the picture by the red box.

Submission settings

Instructions for submission

Maximum number of submission 1T
attachments
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» Step 7: Select Assessment Settings
Teachers can write instructions for assessments online. This is very useful to help
students have a better understanding about the important points of a task before
assessing their classmates’ submissions. After the workshop has been made,

teachers can set more settings related to assessments.
Assessment settings

Instructions for assessment

Use self-assessment Students may assess their own work

» Step 8: Select Feedback
Overall feedback mode
If this is enabled, a text box appears at the bottom of each assessment form for
reviewers to give an overall comment about the submission. Depending on whether
is it set to "Enabled and optional" or "Enabled and required", reviewers will either
have the choice of leaving overall feedback or they will be forced to do so.
Maximum number of overall feedback attachments
Choose how many files you wish reviewers to attach to their overall feedback, up to
a maximum of 7.
Maximum overall feedback attachment size
Decide here how large a feedback file students can upload. The size will depend on

the course upload limit.
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Conclusion

It is possible to add some custom text which the students will see once they reach
the end of the workshop process. This might be a general summary or suggestions
on what should be done next, such as writing a blog post to reflect on the

experience.
Feedback

Overall feedback mode Enabled and optional ¥

Maximum number of overall (UM
feedback attachments

Maximum overall feedback 100MB A
attachment size

Conclusion

» Step 9: Select Example Submissions
There are three options in this drop down menu: The first option means that the
assessment of the example submission is voluntary, while the second and the third
ones make it mandatory, which either requires students to assess example
submissions before submitting their own work or after their own submission but

before peer-assessment.

Note: Assessments of the example submission are not counted when calculating

the grade for assessment.

Example submissions

Use examples Example submissions are provided for practice in assessing

Mode of examples assessment Assessment of example submission is voluntary
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» Step 10: Select Availability

e This section deals with setting submission times and assessment times for the
workshop. That is the time when students can start submitting as well as the
deadline for submitting, and similarly the time assessments for other
students’ work start and when they must finish assessing other students
work.

e All dates - open for submissions from, submissions deadline, open for
assessment from and assessment deadline - are displayed in the course
calendar.

e Availability lets teacher decide if they want a workshop with a closed
schedule or one that is open ended. Setting an opening time but leaving the
deadline open makes it an ongoing activity. To set the opening time and
deadline for either submissions or assessments teachers must click the
enable button next to the option they want to set. Once the enabled has
been checked the 5 drop down boxes will be activated and available for
change.

e The first three boxes correspond to the date and we can either set this box by
box or by selecting the date in the calendar that pops up when any of the
date boxes are selected. The last two boxes correspond to the time in 24
hour time, the first of the two being hours and the second being minutes.
Teachers simply set the desired time for each of the sections they wish to
activate.

e |[f teachers check the box "switch to the next phase after the submissions
deadline", the workshop will automatically switch to the assessment phase

after the next cron job.
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